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Desfragmentacao do disco

Abra o 'My Computer, seleccione a drive c: e clique sobre
'File>Properties>Tools'. Af ira encontrar dados relativos a Ultima vez
que desfragmentou o disco rigido.

Gestao de ficheiros

Podera ir buscar itens a qualquer pasta localizada no 'My Computer
ou no 'Explorer' e depois mové-los ou copia-los para outro local.
Lembre-se que é possivel movimenté-los dentro da pasta, por isso
faga-o até que eles formem um rectangulo. Depois, coloque o
ponteiro do rato no canto superior esquerdo de uma "caixa"
imaginaria contendo os itens, pressione-o e arraste as
extremidades ao largo e ao alto até ao canto inferior direito. Entéo,
surgird um rectangulo picotado. Quando largar o botéao, os itens no
interior do rectangulo estaréo seleccionados.

Activar, desactivar

Alguns utilizadores gostam de trabalhar com o 'NumLock' activado,
outros com ele desactivado. Aqui esta um truque simples se
desejar ter o 'NumLock' activado a maior parte do tempo mas,
ocasionalmente, usar as teclas para outras fungoes: 'Home', End' e
por ai adiante. Basta carregar na tecla 'Shift com o 'NumLock' e o
problema fica resolvido.

Importacdes da calculadora

A pequena aplicagao designada Calculator, que faz parte do menu
'Accessories' (va a 'Add/Remove Programs', no 'Control Panel', para
a adicionar se ela 14 ndo se encontrar) pode aceitar dados de
outras fontes. Digite o célculo numa Unica linha ou numa sucesséo
de linhas e depois copie-o para o Clipboard, colando-o por fim na
calculadora através da combinagéo de teclas 'Alt' + 'E'. Assim,
poderé manipular uma grande quantidade de dados sem ter de se
lembrar dos nimeros.

Simbolos da calculadora

Existem simbolos especiais que devem ser usados ao colar
informagao no Calculator. Por exemplo, digitar :c no teclado limpa a
meméaria e :m armazena um niimero na memoria. Para mais
pormenores, dirija-se a 'Calculator Help>Tips and tricks'.

Memoria da calculadora

Clique 'View>Scientific' para fazer aparecer o ecra do Calculator na
sua plenitude. Se algumas teclas que irao aparecer o confundirem
cligue com o botao direito do rato sobre as mesmas e pressione a
tecla 'What's This'.

Eliminar ficheiros

E sabido que se clicar num item com o botéo direito do rato e
pressionar as teclas 'Shift' + 'Del', o mesmo sera irreversivelmente
eliminado. Lembre-se, porém, que isto acontecera sempre que
remover algo da linha de comandos do MS-DOS, que desconhece
a existéncia do 'Recycle Bin'.

Trugue do Explorer

Uma técnica engragada de movimentagao de ficheiros € arrastar o
ficheiro para uma pasta colapsada no lado esquerdo (que tenha
um sinal '+' numa caixa lateral). Uma subpasta abrir-se-4. Arraste-o
até encontrar a subpasta em que pretende colocar o ficheiro.

(Des)apertar icones

Para ajustar o espaco entre icones no ambiente de trabalho ou na
janela da pasta, tera de ir bem fundo. Clique com o bot&o direito do
rato no ambiente de trabalho e va a 'Properties'. No tabulador
'Appearance’, abra a lista pendente 'ltem' e seleccione a opgéo 'lcon
Spacing' (horizontal). Repare no valor que aparece na caixa — o
padrao é 43, no caso de querer voltar a ele — e depois altere-o a
sua vontade. Podera ainda alterar o espagamento vertical.

Encontrar ficheiros rapidamente

Nas caixas de didlogo 'Open' e 'Save As', se quiser ir até a area da
pasta que comega, digamos, com a letra "P”, seleccione qualquer
ficheiro na lista e pressione a tecla 'P' para aceder ao ficheiro cujo
nome se inicia com essa letra. Mantenha a tecla premida para
aceder aos outros comegados por "P". Quando chegar ao fim,
pressione uma vez mais e estara novamente no primeiro ficheiro
iniciado com "P". Se pressionar "X", por exemplo, e n&o surgir nada,
significa que n&o existe qualquer ficheiro comegado por "X".

Curiosidades do Notepad

Saiba que, se digitar um ponto final no inicio da primeira linha,
seguido de LOG, a hora e data do sistema serao adicionados ao
ficheiro sempre que for carregado.

Execucoes rapidas

Podera abrir pastas usando a janela 'Run', ao digitar o caminho ou
arrastando um icone da pasta a partir do ambiente de trabalho ou
das caixas de dialogo 'File Open' ou 'Save As'. Abra a janela 'Run'
com uma simples backlash (\) para abrir a pasta-raiz da drive
principal. Alguns programas mais antigos podem ser iniciados a
partir da janela 'Run' com uma Unica palavra: "Notepad", "Calc"
(Calculator), "Clipbrd" (Clipboard) ou "Sol" (Solitaire).
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Allows entry of scientific-notation numbers. The exponent is —
limited to four digits. You can use only decimal digits (keys 0 ical = eI i srtically
through 9] in the exponent. You can use Exp only with the
decimal number system. Menu i I elejiifs

Keyboard equivalent =
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Mudar de janelas

Ha um truque inerente ao 'Explorer' e ao 'My Computer' para o caso
de o utilizador querer manter a opgdo de abrir uma janela
correspondente a cada pasta, mas quiser abstrair-se de tal quando
estiver a meio de uma sessao. Basta manter a tecla ‘Ctrl
pressionada e fazer duplo clique na pasta que pretende abrir.

E pronto, a pasta sera aberta na mesma janela.

Quick Launch

Para abrir a barra de ferramentas Quick Launch, pressione com o
botéo direito do rato numa area vazia e dirija-se as opgoes
Toolbars' e 'Quick Launch'. Agora poderd arrastar todas as
aplicagbes que desejar para a barra de ferramentas e af larga-las
para serem rapidamente abertas.

Ordem no PC

Tanto no 'My Computer' como no 'Explorer', na vista 'Details',
poderé clicar nos tabuladores 'Name', 'Size', Type', 'Modified' e
'Attributes', que se encontram no topo da listagem para visualizar
os ficheiros ordenados por nome, tamanho e por af adiante.
Clique duas vezes num tabulador para inverter a ordem da
listagem (por nome de A-Z para Z-A, etc.). Pode ainda arrastar as
barras de categoria para as reordenar. Desse modo, por
exemplo, se quiser ter a data da Ultima modificagdo como a
primeira entrada da sua lista, basta arrastar totalmente esse
tabulador para a esquerda da lista e larga-lo.

Wallpaper problematico

Se quiser guardar uma imagem como papel de parede azulejado
no Paint, mas incidir sobre um pormenor especifico da mesma,
esta podera assumir dimensdes excessivas para servir de azulejo,
pelo que a solucdo dbvia é reduzi-la.

Cahecalhos e rodapés do Notepad

Estes s&o os caracteres especiais (e 0 respectivo significado) que
podera usar nos cabecalhos e rodapés do Notepad:

&f = Nome do ficheiro actual (ou 'Untitled', se ainda n&o Ihe deu
nome)

&p = Numeracéo de paginas

&t = Hora actual do sistema

&d = Data actual do sistema

&l = Alinhar & esquerda

&c = Centrar

&r = Alinhar a direita

E se precisar de adicionar o sinal tipografico '&, digite &&.

R

Mais problemas com o papel de parede

Se carregar um ficheiro no Paint que nao esteja em formato BMP,
ser-lhe-a pedido que o guarde primeiro. Se forcar, o papel de
parede n&o surgira. O truque é guardé-lo em formato BMP na pasta
do wallpaper do Windows.

icones em movimento

Se quiser ordenar os seus icones no lado direito do ambiente de
trabalho, para que metade deles nao desaparega sempre que abre
0 menu 'Start, clique com o botao direito do rato numa zona vazia
do desktop e opte pela categoria 'Arrange Icons By'. Assegure-se
de que o '‘AutoArrange' esté desligado. Em seguida, pressione as
teclas 'Ctrl' + 'A' para seleccionar todos os icones e podera arrasta-
los para a direita do desktop ou até mesmo para fora de vista.

Outro trugue do Send To

Se quiser ajustar as opgdes 'Send To' v4, antes de mais, & pasta
com o mesmo nome. Na janela do lado direito clique com o botao
direito do rato num espaco livre e escolha as opgoes 'New' e
‘Shortcut'. Entéo, navegue através do Windows e seleccione o
ficheiro Notepad.exe. Continue através do assistente e vera que o
Notepad foi adicionado a lista 'Send To'. Deste modo, ser-lhe-&
permitido abrir qualquer ficheiro de texto rapidamente usando o
Notepad, independentemente da extensao do mesmo.

Meio caminho andado

Uma das melhores formas de acelerar o envio de ficheiros para
vérias drives e pastas é personalizando a pasta 'Send To'. Antes de
mais, abra o 'My Computer', dirija-se a pasta 'Windows' (clique em
'Show Files') e abra a pasta 'Send To'. Depois, deixe a janela aberta
e descubra a pasta que contém a sua pasta pessoal. Pressione o
botéo direito do rato sobre ela e arraste-a até a pasta 'Send To'.
Quando largar o botdo, escolha o item 'Create a Shortcut. Da
proxima vez que clicar num ficheiro ou pasta, entre as opgoes de
'Send To' ir4 encontrar a de o/a enviar via atalho para a sua pasta.

Verificar ficheiros

No Windows 98, va a 'Start', 'Run’, e digite SFC, seguido de 'Enter'.
Surgir-lhe-a a ferramenta 'System File Checker', que pode constituir
0 ponto de partida para saber se alguns dos seus ficheiros de
sistema estao desaparecidos. Podera vir a precisar do CD-ROM do
Windows para reinstalar quaisquer ficheiros necessarios.
Provavelmente, tera de reiniciar o computador para efectuar
quaisquer alteragoes, por isso nao se esquega de fechar as
restantes aplicagdes antes de iniciar o SFC.
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Verificar com o teclado

Se tem uma caixa de didlogo aberta e escolher uma checkbox, a
barra de espacos ira activar ou desactivar o sinal de seleccéo.

O efeito € idéntico se clicar numa opgao destacada. Por
exemplo, para abrir uma lista basta pressionar a barra de
espagos quando uma lista pendente esté seleccionada.

Prohlemas de digitacao?

Esta é uma das pérolas ocultas do Office 2000. Dirija-se ao site
de actualizacao do Office
(officeupdate.microsoft.com/2000/download) e descarregue o
utilitario VkeylInst.exe, que sera guardado em
'Start>Programs>Microsoft Office Tools'. Abra o programa e
surgira um teclado com uma série de funcionalidades
interessantes. A primeira dica é que pode pressionar a tecla do
rato no canto direito e arrasta-la para a redimensionar. Podera
mesmo maximiza-la, se necessario.

Janelas voadoras

Um screensaver muito popular é o 'Flying Windows'. Mas se nao
sabia fique a saber que ¢é possivel variar o niimero de janelas
entre 5 e 75, bem como a velocidade das mesmas. Para tal,
aceda ao tabulador 'Screen Saver', em 'Display Properties', e
altere o periodo de tempo a decorrer antes da activagao do
protector de ecré. No entanto, podera fazer ainda melhor. Em 'My
Computer' clique no icone do disco rigido, dirija-se a 'Windows' e
clique em 'Show Files'. Depois, organize os icones por tipo na
pasta 'System' e desga até perto do final, onde se encontra a
maior parte dos seus ficheiros SCR (screensaver).

Desacelerar para encerrar

O Windows 98 encerra-se mais depressa que 0 95, mas néao
encerra adequadamente qualquer aplicagdo que esteja a correr.
Para evitar problemas, percorra o comando 'Accessories>
System Tools>System Information Utility'. No menu Tools', va a
'System Configuration Utility'. O tabulador '‘Advanced' apresenta
uma opgao para desactivar o encerramento rapido.

Protectores automaticos

Mantenha o bot&o direito do rato pressionado sobre um icone do
sceensaver na pasta 'Windows>System' (extensdo SCR), arraste-
0 até ao desktop e crie um atalho. Depois, active um screensaver
instantaneamente, clicando no icone.

Assistente de manutencao

Verificou recentemente a sua maquina de modo a que ela possa
atingir o méximo desempenho? Se néo, dirija-se a
'Accessories>System Tools' e deixe o assistente de manutencao
fazer uma limpeza. No menu de continuagéo encontra a
ferramenta 'Disk Cleanup'.

Feche as janelas

Quer encerrar todas as pastas do 'My Computer? Tem definida a
abertura de uma janela diferente para cada pasta? Entdo, basta
pressionar as teclas 'Alt' + 'Shift' + 'F4'. Conseguira 0 mesmo
resultado usando o rato, a0 mesmo tempo que pressiona 'Shift' e
clica em seguida no botao 'Close'. Tenha em atengédo que isto se
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aplica a pasta actual e as pastas com ela relacionadas, nao as
sub-pastas que ficam 'abaixo’ da mesma.

Quer jogar Solitaire?

Podera restaurar aleatoriamente versos de cartas. Nada mais tera
de fazer do que ir a 'Game>Deck' e seleccionar os versos das
cartas suas favoritas. Um ficheiro INI é entdo criado na pasta
‘Windows’ com a linha 'Back=4', em que o nimero representa o
padréo escolhido. Para restaurar o padrao aleatério edite o
ficheiro SOL.INI, de modo a remover essa linha ou simplesmente
eliminar o ficheiro.

Pausa para reflexao

Se a sua impressora aparentemente deixou de funcionar, é
possivel que tenha assinalado a opgéo 'Pause Printing'
deliberada ou inadvertidamente. Se o icone da impressora esta
no tabuleiro, faga duplo clique sobre ele. Em alternativa, podera
dirigir-se ao menu 'Start> Settings>Control Panel>Printers'.
Finalmente, clique com o botao direito no icone da impressora-
padréo e desactive a opgéo 'Pause Printing'. E de realcar que o
menu pop-up permite igualmente definir a impressora como
padréo ou retirar-lne esse estado. E igualmente possivel fazé-lo
a partir do menu 'File'.

Problemas de imagem

Se tem uma imagem que ndo pode carregar excepto se o
Active Desktop estiver no sitio, poder4 mudar o tipo de ficheiro
para BMP com um programa grafico ou software de conversao
de ficheiros. Em seguida, posicione o ficheiro na pasta
'Windows' e ele poderéa ser usado como fundo normal. Além
disso, este modo pode ser usado para adicionar as suas
préprias imagens de fundo.

Alterar a ordem

Se necessita com urgéncia de uma cépia do Ultimo ficheiro de
uma série que mandou imprimir, s6 tem de fazer duplo clique
sobre o icone da impressora, no tabuleiro Taskbar'. A janela
'Print Queue' ird entdo surgir. Arraste os itens para cima e para
baixo na fila usando o botéao esquerdo do rato. Além disso,
tem a possibilidade de seleccionar qualquer item, ir a
'Document' (Alt' + 'D') e clicar em 'Cancel' ou 'Pause Printing'.
Em alternativa, dirija-se ao item 'Printer' (Alt' + 'P') e escolha a
op¢ao 'Purge Print Documents'.

0 fim dos Recent Files

Para remover a lista 'Recent Files', dirija-se a
'Start>Settings>Taskbar and Start Menu'. Conclua o processo no
tabulador 'Start menu Programs'. O Windows ME apresenta a
opgao 'Delete’, no tabulador 'Advanced'.

Ambhiente de trabalho atulhado

Para evitar que o desktop fique excessivamente cheio, crie uma
pasta de atalhos ao invés de ter uma série de shortcuts
semelhantes dispersos. Para o fazer, pressione com o botao
direito do rato sobre um espago vazio do desktop e seleccione
as opgoes 'New' e 'Folder'. Depois, arraste os itens e largue-os
ai. Abra a pasta para aceder aos atalhos.
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Arrastar uma moldura Barra de ferramentas 'My Computer?
Se quando arrasta uma janela no Windows 98 s6 as linhas Sabia que ¢é possivel arrastar os icones 'My Computer, My
exteriores se movimentam, dirija-se a 'My Computer>View>Folder Documents' e 'My Briefcase' até ao extremo do ecra para criar uma
Options' e clique no tabulador View'. Desga até ver uma caixa de barra de ferramentas? Em seguida, podera arrasta-los para o meio
selecg@o com a frase: 'Show windows contents while dragging'. do desktop para obter barras de ferramentas flutuantes.
Assinale a caixa e faca 'Apply'. Em maquinas lentas, esta operagéo R i
podera néo se revelar muito eficaz. Bem-VIII[llJ mais uma vez
Ha duas formas de recuperar o ecra de boas-vindas no Windows
Pastas em Gascala 98. Antes de mais, abra uma janela no MS-DOS, que, por defeito, &
Clique com o botéo direito do rato numa parte vazia da barra de expandida no directério Windows (a menos que haja alterado esta
tarefas e escolha as opgoes Toolbars' e 'New Toolbar'. Quando a opgao) e digite START WELCOME na prompt..Em alternativa, dirija-
caixa de didlogo surgir, clique sobre 'My Computer' e depois em se ao 'My Computer' ou ao 'Explorer, v4 a pasta 'Windows' e faga
'OK'. Agora tem uma nova barra de ferramentas 'My Computer'. duplo clique no icone 'Welcome.exe'. Uma vez este aberto, assinale
Pressione 'Ctrl' e clique no icone da drive C. Aparecer-lhe-4 uma a caixa que abre a janela 'Welcome' quando o 'Windows' ¢ iniciado.
lista com as pastas. Para aceder aos respectivos contetidos clique
sobre as pastas. Podera ainda arrastar a barra de ferramentas até FichEiros nﬂ menu stan
ao tamanho minimo e clicar na chaveta dupla para obter os Poderé ter algo mais do que aplicagdes no menu 'Start'. Por
mesmos menus em cascata. exemplo, pode querer incluir um ficheiro com uma pagina Web ou
. um documento Notepad ou Word. Use o botao esquerdo do rato e
l-\llldil arraste o icone do documento em causa até ao botdo ‘Start'. Espere
Para copiar texto do 'Help' para o Clipboard cliqgue com o botao até que 0 menu abra e suba pela barra horizontal. A medida que
direito na selecgédo e escolha 'Copy' no menu de contexto. sobe, ira visualizar uma linha horizontal que permite escolher a
L. localizagdo do documento. Assim, poderé personalizar o menu
Recﬂrdar e viver ‘Start' de acordo com as suas necessidades.
Se pretende recuperar o antigo 'File Manager' basta ir a 'Start', 'Run’
e digitar Winfile. E ai esté ele, com uma méao cheia de opgdes de Ra‘o no Ieclalltl
visionamento, mas sem suportar ficheiros com nomes longos. Se pressionar as teclas 'Shift' + 'F10' em simultéaneo, o menu de
contexto da janela actual iré abrir-se. Isso equivale a pressionar o
Prohlemas com [Iisquetes botzo direito do rato. Depois, use as teclas do cursor para se
Se a patilha de protecgdo de metal de uma disquete se estragar movimentar entre os itens. Prima 'Enter' para as seleccionar.
ou ficar dobrada por fora, ndo tente inseri-la na drive. Mas se j& tiver _ -
inserido a disquete retire-a cuidadosamente e volte a inseri-la na Formalacaﬂ I‘allllla
drive - embora 0 melhor seja copiar a disquete usando o comando Se demora demasiado tempo a formatar uma disquete, carregue
DISKCOPY A: A: na linha de comandos do MS-DOS ou, no 'My com o botéo direito do rato sobre o icone da disquete em 'My
Computer', clique com o botdo direito do rato no icone da disquete Computer, escolha a opgdo 'Format' e assinale o item 'Quick
e escolha a opgéo 'Copy Disk'. Siga as instrucoes.. Format'. Deste modo, o trabalho é rapidamente executado, mas
. n&o € feita uma verificagdo em busca de eventuais erros, pelo que
MIWBI’ ou Gﬂlllal’ devera percorrer o caminho mais longo sempre que tiver dividas.
Se arrastar um item de uma pasta para outra na mesma drive
usando o botéo esquerdo do rato, ela sera movida. Para a copiar, Remgiﬂ catita?
pressione 'CTRL' enquanto arrasta a pasta com o botao esquerdo. Para obter um relégico com bom aspecto na barra de tarefas,
Para efectuar uma operacéo de arrastar-e-largar mais segura, use o procure na Web um freeware adequado. Recomendamos-lhe o
bot&o direito do rato. Quando largar o item, um menu surgird com Telock.exe, que permite ver a data e a hora e personaliza-los.
uma série de opgdes, incluindo 'Cancel'.

Abrir os programas

Para que uma aplicagdo corra automaticamente ao iniciar o
Windows, transfira-a para a pasta 'Startup'. Em 'My Computer', v a
localizagdo 'Windows >Start menu>Programs > Startup'. Deixando
essa janela aberta, navegue desde a pasta de raiz até 'Program

Files>Win98RK', arrastando em seguida o atalho 'Quicktray.exe' de
Menu ue co“trom 'Win98RK' para a pasta 'Startup'.

Novas pastas

Quando ha uma pasta aberta no 'My Computer' ou no ‘Windows
Explorer, uma forma de criar outra pasta é pressionando ‘Alt' + 'F'
+ Enter' + Enter. Prima'Alt' + 'F' + 'Enter' (duas vezes neste).

Carregue em 'Alt' e na barra de espagos em simultaneo para abrir o
menu 'Control' (por vezes chamado 'System), que brota do icone no con"olar o som
canto superior esquerdo da barra de menu de uma aplicagao.
Execute esta aplicagao pressionando em simulténeo a tecla 'R' para
restaurar a janela actualmente activa; a tecla X' para a maximizar
ou, finalmente, a tecla 'N' para a minimizar.

Para baixar, aumentar ou ajustar o volume dos sons do Windows ou
de uma cangao que esteja a ouvir, percorra 0 comando ‘All
Programs>Acessories > Entertainment>Volume Control’ e, ai, faca
0s ajustamentos que entender necessarios.
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